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Veuillez consulter votre représentant Epson local pour de plus amples informations ou consulter le site www.epson.fr

Epson France S.A.
Siège social, agence Paris et consommables
BP 320 – 92305 Levallois-Perret CEDEX
Agences régionales : Bordeaux, Lille, Lyon,
Marseille, Nantes, Strasbourg, Toulouse.
Information : 09 74 75 04 04
(Tarif d’une communication locale hors coûts liés à l’opérateur)
Pour plus d’informations, visitez www.epson.fr

Support technique

Produits pour « Particuliers » (imprimantes et multifonctions jet
d’encre, scanners Perfection)
-  Produits sous garantie : 09 74 75 04 04 

(Tarif d’une communication locale hors coûts liés à l’opérateur)
-  Produits hors garantie : 0 899 700 817 

(1,34 EUR/appel et 0,34 EUR/min)

Produits pour « Professionnels » (Laser, Jet d’encre PRO,
Matricielles à impact, Scanner, VidéoProjecteurs, Etiqueteuses,
Imprimantes Points de vente, Billetterie, Etiquettes,
Scanner de chèques, Duplicateurs)
-  Produits sous garantie et hors garantie : 

0 821 017 017 (0,12 EUR/min)

Les marques commerciales et marques déposées sont la propriété de Seiko Epson Corporation ou de leurs détenteurs respectifs.
Les informations sur les produits sont sujettes à modification sans préavis.



ColorWorks C3500 
INSTALLATION DE 
L’IMPRIMANTE
L’imprimante ColorWorks C3500 est fournie avec un CD sur lequel figure les supports suivants :

CONTENU DU CD DESCRIPTION

Install Navi Assistant d’installation pour la 
configuration du pilote et de l’imprimante

NiceLabel SE for EPSON Application pour commencer à concevoir 
et à imprimer des étiquettes avec 
la ColorWorks C3500

EpsonNet Config Configuration et gestion de plusieurs 
imprimantes en réseau

Technical Reference Guide Informations relatives à l’installation de 
l’imprimante, au développement et à la 
conception des applications d’impression

Pour installer l’imprimante ColorWorks C3500, lancez simplement le logiciel Install Navi et suivez 
les instructions illustrées. Elles vous guideront tout au long du processus complet d’installation 
de l’imprimante (du branchement de l'alimentation à l’installation du pilote d’impression).

Voici l’écran d’installation du logiciel EPSON Navi.
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En fonction de la largeur du support, il convient d’ajuster les réglettes du capot pour papier 
rouleau. Si les paramètres des réglettes sont incorrects, cela peut entraîner un bourrage papier 
ou des traces d’encre sur le support.

Veuillez vous reporter à l’étiquette sur le dessus de l’imprimante.

Il est important de veiller à utiliser le paramètre de détection du support approprié. Selon 
le type de support, le paramètre de détection peut être défini sur « Black Mark » (Marques 
noires), « Gap » (Espace) ou « No detection » (Sans détection). De mauvais paramètres sont 
susceptibles de générer une erreur de type « Media Form Error » (Erreur de format de support).



ColorWorks C3500 
IMPRESSION DE LA 
PREMIèRE éTIquETTE 
(AvEC LE LOgICIEL NiceLabel FOuRNI)

Remarque : Toutes les imprimantes d’étiquettes couleur ColorWorks C3500 sont fournies 
avec le logiciel « NiceLabel Starter Edition (SE) for Epson ». NiceLabel dispose de l’interface 
EPDI (EPSON Printer Driver Interface) intégrée. Cette API permet de modifier les paramètres 
du pilote à partir de l’application utilisateur.

Lancez l’application NiceLabel 

1.  Définissez la taille d’étiquette lors de la création d’une nouvelle étiquette

2. Ajoutez les textes, codes-barres, images ou graphiques que vous souhaitez 

3.  Utilisez le bouton « Color » (Couleur) pour apporter de la couleur au contenu des étiquettes 
(par exemple, texte/images)

4.  Sélectionnez « File » (Fichier)  « Printer Settings » (Paramètres de l’imprimante) pour 
modifier le paramètre du support (par exemple, mat, brillant, synthétique) ainsi que les 
paramètres de qualité. Validez ensuite vos choix en appuyant sur « OK » 

5.  Sélectionnez « File » (Fichier)  « Print ... » (Imprimer...) et appuyez sur « Print » pour 
imprimer votre première étiquette
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ColorWorks C3500 
IMPRESSION DE LA 
PREMIèRE éTIquETTE 
(AvEC uN AuTRE LOgICIEL)

Remarque : Les applications ne disposant pas de l’interface EPDI (EPSON Printer Driver 
Interface) doivent utiliser les mises en page pré-définies du pilote.

1. Enregistrer un nouveau format d'étiquette

  a) Ouvrez le pilote de la ColorWorks C3500
(« Devices & Printers » (Périphériques et imprimantes) -> (clic-droit) Epson ColorWorks 
C3500 -> (cliquez sur) « Printing Preferences » (Options d’impression)

b) Cliquez sur « User Defined » (Défini par l'utilisateur)

c) Saisissez le nom de la mise en page (par exemple, « Étiquette Chaussure »)

d) Sélectionnez le format du support

e) Saisissez la largeur et la hauteur de l’étiquette

f) Cliquez sur « Add » (Ajouter)

2. Ouvrez le modèle d’étiquette (fichier) dans un logiciel Windows standard
  - (exemple : en cas de fichier image, veuillez utiliser Microsoft Photo Viewer)

3. Cliquez sur « Print » (Imprimer) (ou Ctrl + P)

  - Dans la fenêtre du menu d’impression, sélectionnez :

 a. Pour "Printer" : sélectionnez "Epson ColorWorks C3500"

 b. Pour "Paper size" : sélectionnez "Shoe label"

 c. Optez pour « Quality » (Qualité) ou « Speed » (Vitesse) en termes de qualité d’impression

 d.  Pour "Paper type", sélectionnez le type de support utilisé (exemple  : "glossy label" 
pour du média brillant)

  -  Saisissez le nombre d’étiquettes que vous souhaitez imprimer et cliquez sur « Print » 
(Imprimer)

Microsoft Photo Viewer (Windows 7) 
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DESCRIPTION DE LA 
POSITION DU SUPPORT PARAMÈTRE DE DÉTECTION

Die-Cut Label (Gap)
Etiquette pré-découpée (avec espace)

Détection de l’espace entre les 
étiquettes

Die-Cut Label (BM)
Etiquette pré-découpée (à marque noir)

Détection de marques noires entre 
les étiquettes

Full-page Label
Etiquette continue

Sans détection

Continuous Paper
Papier continu

Sans détection

Black Mark Continuous Paper
Papier continu à marque noir

Détection des marques noires



ColorWorks C3500 
PILOTE
Via plusieurs onglets, le pilote d’impression EPSON ColorWorks C3500 donne accès aux 
différentes options et fonctionnalités de l’imprimante. En voici une présentation : 

1. Onglet « General » (Général)

-  « Print Settings » (Paramètres d’impression) => « Media Type » (Type de support) : Plain 
(standard), Matte, Glossy (brillant) 

Le tableau ci-dessous présente une description plus détaillée 
des paramètres Media Type (Type de support) disponibles 
dans le menu déroulant.

TyPE DE SUPPORT DESCRIPTION

Plain (Simple) Papier non couché

Plain Label (Etiquette simple) Étiquette non couchée

Synthetic Label (Etiquette synthétique) Étiquette synthétique couchée

Matte (Mat) Papier mat couché

Matte Label (Etiquette Mat) Étiquette Mate Couchée

Wristband (Poignet) Bracelet synthétique

Glossy Label (Etiquette Brillante) Étiquette Brillante Couchée
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Paramètres relatifs à la qualité d’impression speed / quality

- « Media Layout » (Mise en page) 
   (définition de la taille du support) ; « Roll Paper Saving »  
  (suppression des marges sur les étiquettes)

-  Paramètres du massicot => « Auto Cut »/« No Auto Cut » (Découpe automatique/Sans 
découpe automatique)

- Paramètres des signaux sonores => beep (bip après chaque impression)/No bip (sans)

2. Options :

- Modifier l’orientation de l’impression (portrait/paysage)

3. « Driver Utilities » (Utilitaires du pilote) :

- Préférences du pilote (unités de mesure, moniteur d’état, etc.)

- Moteurs d’impression de codes-barres internes

- Importer/Exporter les paramètres du pilote

4. Maintenance et utilitaires

-  Vérification des buses (Nozzle Check) => imprimez un modèle de vérification des buses 
pour vérifier si une des buses est obstruée

-  Nettoyage manuel de la tête (Manual Head Cleaning) => effectuez un nettoyage de la tête 
en cas d’obstruction des buses

- Paramètres de l’imprimante (Printer Settings) => se référer au chapitre suivant



Informations 
générales

Media Settings 
(Paramètres du support)

Media Source Settings (Paramètres 
de source de support)

Définir l’imprimante pour utiliser le type de support 
Rouleau ou Accordéon

Media Position Detection Settings 
(Paramètres de détection de la 
position du support)

Définir le capteur de détection du support de 
l’imprimante (No detection/Black mark/Gap 
(Sans détection/Espace/Marques noires))

Printer Operation 
Settings (Paramètres 
de fonctionnement de 
l’imprimante)

Nozzle Check Mode Settings 
(Paramètres du mode de vérification 
des buses)

Pour en savoir plus, consulter le Manuel de référence 
technique

Paper loading settings (Paramètres 
de chargement du papier)

Définir le comportement de l’imprimante lorsqu’elle 
est sous tension ou une fois le capot fermé (par 
ex. : alimenter le papier en position découpe ou 
impression)
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Advanced 
Settings 
(Paramètres 
avancés) 

Notify Settings 
(Paramètres de notification)

Notify Settings 
(Notifier les paramètres)

Définir la notification de l’imprimante (bip ou LED) 
à la fin de l’impression, en cas d’erreur ou en cas de 
niveau d’encre faible

Panel button settings 
(Paramètres du panneau 
de control)

Panel Button settings (Paramètres 
du panneau de control)

Activer/Désactiver les boutons (découpe, 
alimentation ou nettoyage) sur le panneau 
de l’imprimante

Operating time settings 
(Paramètres de 
fonctionnement)

Platen vacuum settings (Paramètres 
des plaques sous vide)

Pour en savoir plus, consulter le Manuel 
de référence technique

Data stand-by settings (Paramètres 
des données en veille)

Pour en savoir plus, consulter le Manuel 
de référence technique

Printer 
Adjustment 
(Réglage de 
l’imprimante)

Paper feed adjustment 
(Ajustement de 
l’alimentation papier)

Cut position adjustment (Ajustement 
de la position de coupe)

Ajuster la position exacte de découpe après 
impression (par tranches de 1/180 pouce)

Print start position adjustment - 
vertical (Ajustement de la position au 
démarrage de l’impression - verticale)

Ajuster la position exacte au 
démarrage de l’impression - depuis 
le  bord supérieur du support (par tranches 
de 1/180 pouce)

Print start position adjustment 
(Ajustement de la position de 
démarrage de l’impression) 
- horizontal (horizontale)

Ajuster la position exacte de démarrage 
de l’impression - depuis le bord gauche 
du support (par tranches de 1/180 pouce)

Sensor adjustment 
(Ajustement du capteur)

Adjust label gap sensor (Ajuster 
la détection des espaces entre 
les étiquettes)

Pour en savoir plus, consulter le Manuel 
de référence technique

Adjust black mark sensor (Ajuster 
la détection des marques noires)

Pour en savoir plus, consulter le Manuel 
de référence technique

Print head alignment 
(Alignement de la tête 
d’impression)

Banding adjustment (Ajustement 
de l’effet de bande)

Ajustement de la tête d’impression (horizontal) pour 
éviter l’effet de bande (lignes blanches ou foncées) 
sur les impressions

Bi-directional printing adjustment 
(Ajustement de l’impression bi-
directionnelle)

Ajustement de la tête d’impression (vertical) pour 
éviter l’effet de bande (lignes blanches ou foncées) 
sur les impressions

Settings Save 
and restore 
(Enregistrement 
et restauration 
des paramètres)

/ Settings Save and Restore 
(Enregistrement et restauration 
des paramètres)

Créer ou charger le fichier de sauvegarde avec les 
paramètres actuels de l’imprimante

Option / Media Source Settings (Paramètres 
de source de support)

Activer l’utilisation de rouleaux externes (dérouleur 
externe requis)

CATÉGORIE SECTION PARAMÈTRE DESCRIPTION

ColorWorks C3500 
uTILITAIRE DES PARAMèTRES 
DE L’IMPRIMANTE

Le "Printers Settings Utility" ou PARAMÈTRES DE L’IMPRIMANTE, vous permet de configurer 
plusieurs paramètres de l’imprimante, tels que :



IMPRESSION COLORWORKS C3500 - 
DéPANNAgE

MEDIA COLORWORKS C3500 - 
DéPANNAgE
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Définissez une nouvelle mise en page
General (Général) -> Media Layout (Mise en page) 
-> User defined (Personnalisée) (pas nécessaire si 
vous utilisez le logiciel NiceLabel) …dans la même 
fenêtre, avant d’enregistrer la nouvelle mise en page, 
sélectionnez « Borderless printing » (Impression 
bord-à-bord)

Modifiez la méthode de détection du support de 
l’imprimante via le pilote ou l’utilitaire des paramètres :
Pilote : General (Général) -> Media (Support) -> 
Media Position Detection (BM/Gap...) (Détection 
de la position du support (marque noire/Espace…) 
Utility (Utilitaire) : General (Général) -> Media Settings 
(Paramètres du support) -> Media position detection 
settings (Paramètres de détection de la position 
du support)

Si le nouveau support a une largeur différente :
Ajustez les réglettes, voir page 2

Paramètres du pilote 
Windows

Définissez une nouvelle mise en page 
General (Général) -> Media Layout (Mise en page) -> 
User defined (Personnalisée) (pas nécessaire pour 
les applications utilisant l’interface EPDI, telle que 
NiceLabel)

Définissez une nouvelle mise en page 
General (Général) -> Media Layout (Mise en page) -> 
User defined (Personnalisée) (pas nécessaire pour 
les applications utilisant l’interface EPDI, telle que 
NiceLabel)

Définissez une nouvelle mise en page 
General (Général) -> Media Layout (Mise en page) -> 
User defined (Personnalisée) (pas nécessaire pour 
les applications utilisant l’interface EPDI, telle que 
NiceLabel)

Définissez une nouvelle mise en page 
General (Général) -> Media Layout (Mise en page) -> 
User defined (Personnalisée) (pas nécessaire pour 
les applications utilisant l’interface EPDI, telle que 
NiceLabel)

Paramètres du matériel 
d’impression

Si le nouveau support a une largeur différente : 
Ajustez les réglettes, voir page 2

Si le nouveau support a une largeur différente : 
Ajustez les réglettes, voir page 2

Si le nouveau support a une largeur différente : 
Ajustez les réglettes, voir page 2
En cas d’utilisation d’un papier accordéon, 
utilisez le guide papier plastifié situé à l’arrière

Si le nouveau support a une largeur différente : 
Ajustez les réglettes, voir page 2
Utilisez le guide papier plastique situé à l’arrière

Paramètres du logiciel 
d’impression

-

Modifiez les paramètres du support depuis l’utilitaire 
Paramètres :
Détection de la position du support : General 
(Général) -> Media Settings (Paramètres du support) 
-> Media position detection (Détection de la position 
du support) Media Source setting (Paramètre de 
source de support) : General (Général) - > Media 
Settings (Paramètres du support) -> Media Source 
(Source de support)

Option -> Media Source Settings (Paramètres 
de source de support) : 
Activez l’utilisation des rouleaux externes 
Modifiez les paramètres de détection de la position 
du support : General (Général) -> Media Settings 
(Paramètres du support) -> Media position detection 
settings (Paramètres de détection de la position 
du support)
Modifiez les paramètres de source de support (rouleau 
externe) : General (Général) -> Media Settings 
(Paramètres du support) -> Media Source (Source 
de support)

1

2

3

4

1

-

Utilisez l’utilitaire des paramètres de l’imprimante pour 
l’installation :
Printer adjustment (Ajustement de l’imprimante) 
-> Paper Feed adjustment (Ajustement 
de l’alimentation papier) : 
Ajustement de la position de démarrage 
de l’impression (direction verticale) 
Ajustement de la position de démarrage 
de l’impression (direction horizontale) 

Si le nouveau support a une largeur différente :
Ajustez les réglettes, voir page 2

2

-
Utilisez l’utilitaire des paramètres de l’imprimante 
pour l’installation :
Printer adjustment (Ajustement de l’imprimante) -> 
Paper Feed adjustment (Ajustement de l’alimentation 
papier) : Ajustement de la position de coupe

-
3

-
Utilisez l’utilitaire des paramètres de l’imprimante 
pour la configuration : Printer adjustment 
(Ajustement de l’imprimante) -> Print Head 
Alignement (Alignement de la tête d’impression) 
-> Banding adjustment (Ajustement de l’effet 
de bande)

-
4

Je souhaite ...

... utiliser un nouveau support d’une autre taille, mais de même type (découpé, continu, etc.)

... utiliser un nouveau type de support (de/à : découpé, continu, avec marques noires)

... passer du rouleau au support en accordéon (ou autre)

... utiliser le support de rouleau externe

Je souhaite ...

... imprimer sans marge

... ajuster la position exacte de la coupe sur le papier 

... me débarrasser de l’effet de bande (lignes blanches ou plus sombres sur les impressions)

... ajuster la position exacte de l’impression sur le papier (à l’horizontale ou à la verticale)

11
22
33
44

Paramètres du matériel 
d’impression

Paramètres du logiciel 
d’impression

Paramètres du pilote 
Windows

Modifiez la méthode de détection du support de 
l’imprimante via le pilote ou l’utilitaire Paramètres :
Pilote : General (Général) -> Media (Support) 
-> Media Position Detection (BM/Gap...) 
(Détection de la position du support (marques 
noires/Espace…)
Utilitaire : General (Général) -> Media Settings 
(Paramètres du support) -> Media position 
detection settings (Paramètres de détection 
de la position du support)

11
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À ne pas 
faire

À ne pas 
faire

À faire

À faire

CE quE vOuS DEvEz SAvOIR 
LORSquE vOuS IMPRIMEz 
DES éTIquETTES AvEC LA 
ColorWorks C3500

14

Installez correctement l’imprimante

Ne vous attendez pas à démarrer l'impression 
d'étiquettes immédiatement après l'ouverture 
du carton de l'imprimante

Dans un premier temps, exécutez InstallNavi pour configurer l’imprimante 
(InstallNavi est disponible sur le CD fourni dans le carton ColorWorks C3500). 
Familiarisez-vous avec le pilote et l’utilitaire des paramètres de l’imprimante ainsi 
qu’avec l’imprimante en elle-même. N’oubliez pas d’ajuster les réglettes sur la 
ColorWorks C3500 chaque fois que vous utilisez un nouveau support ayant une 
largeur différente.

Utilisez des étiquettes couchées 
jet d’encre

Les étiquettes à transfert thermique et à transfert thermique direct ont un autre type 
de revêtement supérieur que les étiquettes jet d’encre, empêchant ainsi l’encre 
de sécher instantanément. Généralement, cela génère des tâches d’encre sur 
vos étiquettes.

N’utilisez pas des étiquettes 
conçues pour d’autres imprimantes/
technologies
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Support

Type

Ticket  
Premium mat

•

•

Etiquette  
Premium Mate

•

•

•

•

•

•

•

•

Étiquette High Gloss •

•

•

•

•

•

•

•

Étiquette PE Mate •

•

•

•

•

•

•

•

Format

Rouleau de papier continu

Rouleau de papier continu

Rouleau d‘étiquettes continu

Rouleau d‘étiquettes continu

Rouleau d‘étiquettes continu

Rouleau d‘étiquettes pré-découpées

Rouleau d‘étiquettes pré-découpées

Rouleau d‘étiquettes pré-découpées

Rouleau d‘étiquettes pré-découpées

Rouleau d‘étiquettes pré-découpées

Rouleau d‘étiquettes continu

Rouleau d‘étiquettes continu

Rouleau d‘étiquettes continu

Rouleau d‘étiquettes pré-découpées

Rouleau d‘étiquettes pré-découpées

Rouleau d‘étiquettes pré-découpées

Rouleau d‘étiquettes pré-découpées

Rouleau d‘étiquettes pré-découpées

Rouleau d‘étiquettes continu

Rouleau d‘étiquettes continu

Rouleau d‘étiquettes continu

Rouleau d‘étiquettes pré-découpées

Rouleau d‘étiquettes pré-découpées

Rouleau d‘étiquettes pré-découpées

Rouleau d‘étiquettes pré-découpées

Rouleau d‘étiquettes pré-découpées

Taille

80 mm × 50 m

102 mm × 50 m

51 mm × 35 m

76 mm × 35 m

102 mm × 35 m

102 mm × 51 mm (500 étiquettes)

102 mm × 76 mm (440 étiquettes)

102 mm × 152 mm (225 étiquettes)

76 mm × 51 mm (650 étiquettes)

76 mm × 127 mm (265 étiquettes)

51 mm × 33 m

76 mm × 33 m

102 mm × 33 m

102 mm × 51 mm (610 étiquettes)

102 mm × 76 mm (415 étiquettes)

102 mm × 152 mm (210 étiquettes)

76 mm × 51 mm (610 étiquettes)

76 mm × 127 mm (250 étiquettes)

51 mm × 29 m

76 mm × 29 m

102 mm × 29 m

102 mm × 51 mm (535 étiquettes)

102 mm × 76 mm (365 étiquettes)

102 mm × 152 mm (185 étiquettes)

76 mm × 51 mm (535 étiquettes)

76 mm × 127 mm (220 étiquettes)

Code

C33S045389

C33S045390

C33S045417

C33S045418

C33S045419

C33S045531

C33S045532

C33S045533

C33S045534

C33S045535

C33S045536

C33S045537

C33S045538

C33S045539

C33S045540

C33S045541

C33S045542

C33S045543

C33S045544

C33S045545

C33S045546

C33S045547

C33S045548

C33S045549

C33S045550

C33S045551

•

 

Compatible avec l'imprimante
Pour la liste complète des supports disponibles, consultez le site : 

Consommables

Nom Type Capacité Code Image

SJIC22P(C) Cyan 32,5 ml C33S020602

SJIC22P(M) Magenta 32,5 ml C33S020603

SJIC22P(Y) Jaune 32,5 ml C33S020604

SJIC22P(K) Noir 32,6 ml C33S020601

SJMB3500 Mallette d‘entretien / C33S020580

SJIC15P 3 couleurs CMJ 78,9 ml C33S020602

SJIC20(K) Noir 78,7 ml C33S020602

GJIC5(C) Cyan 32,5 ml C13S020564

GJIC5 (M) Magenta 32,5 ml C13S020563

GJIC5(Y) Jaune 32,5 ml C13S020565

GJIC5(K) Noir 97,8 ml C13S020566

Imprimantes

Nom Type Code

TM-C3500 USB et  
Ethernet

C31CD54012CD

TM-C3400 USB C31CA26012

Ethernet C31CA26032

TM-C3400-LT / C31CC35021

TM-C3400BK USB C31CA26122

Ethernet C31CA26132

GP-C831 USB et  
Ethernet

C11CC68132

Liste des imprimantes et consommables

C
o

lo
rW

o
rks C

3500
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À ne pas 
faire

À ne pas 
faire

À faire

À faire

Utilisez le type de support jet d’encre 
approprié

Ne pensez pas que toute étiquette 
couchée jet d’encre peut être 
appropriée pour tout type d'application

En matière de support jet d’encre, il convient de tenir compte de 2 points : 

  - revêtement (mat, brillant), qui est responsable de la qualité d’impression ; et

  -  matériel de base (papier ou synthétique/film), qui est responsable de la durabilité 
de l’étiquette

Les étiquettes synthétiques ont une meilleure longévité que les étiquettes papier 
et sont recommandées pour une utilisation avec les applications où les liquides 
entrent en contact avec l’étiquette.

Vous découvrirez de nombreux supports Epson d’origine sur le site suivant :
www.epson.fr/colorworks

Attendez-vous à imprimer des étiquettes 
couleur de qualité supérieure

Les imprimantes 4 couleurs offrent une bonne qualité d’impression, mais ne peuvent 
pas proposer une gamme de couleurs étendue. La correspondance parfaite 
des couleurs n’est possible qu'avec les presses industrielles numériques ou 
analogiques (utilisées par les transformateurs d’étiquettes).

Ne vous attendez pas à une 
correspondance de couleurs Pantone

www.epson.fr/colorworks/media
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Ajoutez à vos étiquettes des images et 
du texte en couleur

N’inondez pas les étiquettes 
couchées d’encre

La ColorWorks C3500 peut créer des « bandes » en raison d’espacements/
chevauchements de la tête d’impression lors de l’impression de grands blocs 
de couleurs. La réduction du phénomène de bande est possible via l’utilitaire 
de paramètres de l’imprimante. Cela dit, le phénomène ne peut pas être totalement 
masqué/évité.

Utilisez un logiciel professionnel de 
création d'étiquettes pour imprimer 
les codes à barres.

Un logiciel de création d’étiquettes (tel que NiceLabel) génèrera le code à 
barres exactement à la taille, la résolution et la qualité nécessaires pour être 
parfaitement scanné.

Si, en outre, les codes à barres sont codés en dur dans l’image, et si l’image est 
étirée, ceux-ci seront redimensionnés, sans conserver le rapport requis (largeur/
longueur des barres), ce qui peut entraîner des difficultés à scanner ces codes 
à barres.

Ne codez pas dans le dur les codes à 
barres dans le fichier d’origine du modèle 
d’étiquette (jpg, pdf, etc.)
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Laissez 1,5 mm de marge sur l’étiquette

N’imprimez pas les étiquettes bord 
à bord (sans marges)

La ColorWorks C3500 vous permet d’étendre la zone d’impression. Cela dit, 
il y a un risque de transfert d’encre du film protecteur vers l’étiquette ou vos doigts 
(lors du décollement de l’étiquette).

Utilisez des fichiers images non 
compressés, haute résolution

La ColorWorks C3500 dispose d’une résolution native de 360 dpi. Cette 
imprimante sera en mesure d’offrir les meilleurs résultats d’impression avec des 
images ayant des multiples de cette résolution : 360 dpi, 720 dpi ou 1440 dpi.

N’imprimez pas d’images de faible 
résolution
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Modifiez le mode de détection du support 
avant d'insérer un nouveau support

Ne gardez pas le même mode de détection 
du support lorsque vous basculez d’un papier 
rouleau à l’autre, car un message d’erreur 
apparaîtra à l’écran.

Si vous passez d'un mode de détection avec marques noires à une détection 
des espaces, veuillez modifier les paramètres de l’imprimante via le pilote ou 
l’utilitaire en gardant le support initial (à marques noires) dans l'imprimante.

Ce n’est qu’après avoir appliqué la nouvelle méthode de détection, que vous 
pouvez changer et insérer le support avec espaces.

Vérifiez la détection de la position 
du support.

Un message d’erreur de format de support apparaîtra si le paramètre de détection 
de la position du support n’est pas correctement configuré. 

Par exemple, l’imprimante est définie pour détecter les marques noires, mais un 
papier rouleau sans marque noire est chargé. En cas d’erreur de type « MEDIA 
FORM ERROR » (ERREUR DE FORMAT DE SUPPORT), désactivez l’imprimante. 
Supprimez toute tâche d’impression en attente dans le gestionnaire Activez 
à nouveau l’imprimante. Accédez aux Options du pilote ou aux paramètres 
Utilitaires pour modifier les paramètres de détection. Appuyez sur le bouton 
Feed (Alimenter) pour confirmer que le message d’erreur de type « MEDIA FORM 
ERROR » a disparu.

Ne considérez pas que la détection du 
support est configurée automatiquement.




